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TSL2584TSV 

The TSL2584TSV is a very-high sensitivity light-to-digital converter that transforms light intensity 
into a digital signal output. The device combines one broadband photodiode (visible plus infrared), 
one infrared-responding photodiode, and a photopic infrared-blocking filter on a single CMOS 
integrated circuit. 

Initial hardware setup 

The software should be installed prior to connecting any hardware to the computer. Follow the 
instructions found in the Quick Start Guide (QSG). This will load the required driver for the USB 
interface and also the control software and graphical user interface (GUI).  

 

The hardware consists of the EVM Controller v2.1a or v2.1c, the TSL2584TSV EVM daughterboard, 
a USB interface cable and USB Memory Stick. 

 

 

When the USB cable is connected, the green LED should flash indicating that power is being 
received via the USB interface, and the controller board processor is running. If the green LED does 
not flash, check the USB cable connections; unplug the USB cable and try again. If the green LED 
still does not flash, check the PC for USB error messages.  

 

See the Resources section at the end of this document for additional assistance. 
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1 Establishing basic functionality 
The software should be started using the ams->TSL2584TSV_EVM->TSL2584TSV_EVM command 
in the Windows menu or by double clicking the AOS_EVM.exe file from the installation directory. 
The default installation directory, depending on the device and the operating system you are using, 
is: 

 
C:\Program Files\ams\TSL2584TSV_EVM Windows 32 bit operating systems 

C:\Program Files (x86)\ams\TSL2584TSV_EVM Windows 64 bit operating systems 

 

A different install path may be selected by the user. When started, the TSL2584TSV window will 
open on the PC. 

 

The balance of this document identifies and describes the controls available on the GUI. In 

combination with the TSL2584TSV datasheet, the QSG and application notes available on the ams 
website, www.ams.com.  There should be enough information to allow evaluation of the 
TSL2584TSV device. 

2 TSL2584TSV EVM graphical user interface (GUI) 

2.1 Software overview 

On successful initialization the software displays a main window, containing controls pertinent to the 
connected device. If the software detects an error it will display an error window. 

If “Device not found or is unsupported” appears, verify that the correct daughterboard is properly 
connected to the motherboard. If “Cannot connect to EVM board” appears, verify the USB cable is 
connected. A green LED on the EVM Controller will flash to indicate that the USB cable is 
connected and providing power to the system. 

If the EVM board is disconnected from the USB bus while the program is running it will display an 
error message and then terminate.  Reconnect the EVM board and restart the program. 
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The main window for the TSL2584TSV is shown below. 

 

 

 

Clicking on the red “X” will close the window and terminate the application. 

 

The checkboxes near the top of the window power on the chip and enable the ALS function. The 
ALS tab contains controls for the remaining functions and displays status and data from the device 
as it operates. 

 

2.1.1 Device ID Information 

The lower left corner of the window displays the ID number of the EVM motherboard, identifies the 
device being used and displays the ID of the device. 
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2.1.2 Log Status and Control Information 

The lower right corner of the window contains status information and controls for the logging 
function: 

 

 

 

This section contains two text boxes that are stored in the log file data and used to build the file 
name for the log file. If you change the data in these fields, the new values will be stored with all 
new log data. The default log file name will be based on these values at the time the log file is 
written. If nothing is entered in these boxes they default to a period (“.”). 

Sample default file name: 

TSL2584TSV_A-B-C_1-2-3_Log.csv 
                               

       From DigitalLightSensor.exe 

       From User Input 

The Count  value displayed is a count of the number of samples currently in the log buffer. 

The Elapsed Time  value indicates the elapsed time since data logging was started. 

The final field in this section controls the number of log samples that will be collected before logging 
is automatically stopped and the log data is stored.  If the count of log entries reaches the amount 
shown in this field the program will stop the logging function and pop up a window asking for a file 
name to save the collected data. 

2.1.3 System Menus 

At the top of the window there are three pull-down menus labeled “File”, “Log”, and “Help”. The File 
menu provides basic application-level control. The Log menu is used to control the logging function, 
and the Help menu provides version and copyright information for the application. 

2.1.3.1 File Menu 

The File menu contains the following functions: 

 

The Reread Registers  function forces the program to re-read all of the control registers from the 
device and display them on the screen.  This does not read the status and ALS result registers, 
because those registers are continually read while the program is running. 

Click on the Exit  command to close the main window and terminate the application. 
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2.1.3.2 Log Menu 

The Log menu is used to control the logging function and to save the log data to a file. Log data is 
accumulated in memory until it is discarded or written to a data file. 

 

Click Start Logging  to start the logging function. Each time the program polls the ALS information 
from the device, it will create a new log entry showing the raw data values, the calculated lux value, 
the values of various control registers, and the values entered by the user into the text fields near 
the bottom right corner of the window. 

Click Stop Logging  to stop the logging function. Once logging is stopped, the data can be written to 
a file, or you can continue collecting additional data by clicking Start Logging again. 

The Log a Single Entry  command, will cause logging to be start, collect one single entry, and 
immediately stop again.  This function is not available when logging is already running. 

Click Clear Log  to discard any data that has already been collected.  If there is data in memory, 
which has not been saved to disk, this function will display a prompt asking if you to verify that it is 
OK to discard the data. If the log is running when this function is clicked, the log will continue 
running after the existing data is discarded. 

Click Save Log  to save the collected log data to a data file.  This will stop the logging function, if it is 
active, and display a file dialog box for you to specify where to store the logged data.  The default 
file name, as described above, will be displayed, but you may change the file name if you wish. 
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2.1.3.3 Help Menu 

The Help menu contains a single function; About. 

 

The About  function displays a dialog box showing the version and copyright information for the 
AOS_EVM program and library. 

 

Click the OK button to close this window and continue. 

2.1.4 System Level Controls 

Immediately below the top menu bar there are two checkboxes that are used to control the system 
level functions of the TSL2584TSV device. 

The Power-On  checkbox controls the PON function of the TSL2584TSV. When this box is checked, 
the power is on and the device can operate. When this box is unchecked, the power is off and the 
device will not operate (The control registers can still be written, but the device will not function). 

The ALS Enable  checkbox controls the ADC_EN function of the TSL2584TSV. When this box is 
checked, the device will collect and report ALS data as programmed. When this box is unchecked, 
the ALS functions will not operate. 

2.1.5 “ALS” Tab 

The main portion of the screen contains a single tab, labeled ALS. The controls in this tab are 
divided into 4 sections, each performing a separate function. 
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2.1.5.1 ALS Controls 

The top left corner of the ALS tab contains two controls; one to set the ALS integration time and 
another to control the ALS gain. 

The ITIME control sets the time of the ALS integration. ITIME can be adjusted in 2.72ms steps. This 
register functions as a count-down value so ITIME=255 is the minimum integration time (2.72ms) 
and ITIME=1 is the maximum integration time (693.6ms). Note that ITIME=0 is a special manual 
mode which uses specific I2C commands to start and stop the integration cycle. Because of the 
high timing accuracy required to execute in this mode, it cannot be supported in the AOS_EVM 
software.  The actual integration time, in milliseconds, is displayed next to this control. If 0 is 
selected, the time display will be shown as “Manual Mode”. 

The Gain  control is a pulldown menu which lets you select the analog gain of the device. The 
values that can be chosen are 1x, 8x, 16x, and 111x. 

2.1.5.2 Interrupt Controls 

The lower left corner of the ALS tab contains controls for the interrupt functionality of the device. 
The ADC_INTR signal can be triggered when the CH0 data values are higher than a programmed 
low threshold or higher than a programmed high threshold. 

The Enable  checkbox is checked to enable the ADC_INTR signal.  Checking this box, allows the 
interrupt signal to be generated. 

The ADC_INTR indicator indicates whether the interrupt is active.  When the interrupt is NOT 
active, this will display an empty box. When the interrupt is active, this box will be marked. Clicking 
on this box will clear the interrupt signal. (Note, depending on the remaining register settings the 
interrupt may be raised again immediately.) 

The Low  and High  controls allow you to set thresholds for the CH0 data value. If the CH0 value is 
less than the low threshold or more than the high threshold for more times that specified in the 
persistence register, the interrupt will be activated. 

The Pers  control sets the persistence value.  It controls how many consecutive times that a 
threshold must be exceeded before the interrupt is raised. A setting of 0 for this register will cause 
the interrupt to be raised after every ALS cycle, regardless of the threshold settings. Setting this 
value from 1 through 15 requires that the threshold must be exceeded for 1 to 15 consecutive 
cycles before the interrupt is raised. 

Checking the Stop On Interrupt  checkbox causes the device to stop processing ALS data 
whenever the interrupt is raised. To continue processing ALS data, the interrupt must be cleared 
either by clicking on the ADC_INTR indicator or by disabling and enabling the interrupt. 

2.1.5.3 ALS Output Data 

The top right corner of the ALS tab displays the data which is output by the device. 

CH0 displays the raw Channel 0 ADC count. 

CH1 displays the raw Channel 1 count. 

Ratio  displays the ratio of CH1 to CH0. 

Lux  displays the calculated lux value which is a function of CH0, CH1, ITIME, and Gain. 
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2.1.5.4 ALS Data Plot 

The remaining portion of the ALS tab is used to display a running plot of the collected ALS values 
and the calculated lux values. The last 350 values are collected and plotted on the graph. As 
additional values are added, the old values will be deleted from the left side of the graph. 
 

 
 
The Enable Plot  checkbox activates the plotting function.  Data will only be plotted when this box is 
checked. 
The CH0, CH1, and Lux  checkboxes control which values will be displayed on the plot.  Only the 
checked values will be displayed. 
Click the Clear Plot  button to discard the current data and continue plotting the new data. Note, if 
the Clear Plot button is clicked while the plot is disabled, the data is discarded, but the actual plot 
will not be updated until the plot function is re-enabled. 
The Scale  of the Y-axis of the plot can be adjusted by clicking on the small up and down arrows at 
the top left corner of the plot. The scale can be set to any power of 2 from 64 through 65536. 
 

3 Resources 
 

TSL2584TSV datasheet 

TSL2584TSV EVM Quick Start Guide (QSG) 

Designer’s Notebooks 

 

For additional information regarding the TSL2584TSV, please refer to the datasheet. For 
information regarding the installation of the TSL2584TSV EVM host application software please 
refer to the TSL2584TSV EVM Quick Start Guide. 

 

Designer’s Notebooks dealing with various aspects of optical measurement and optical 

measurement applications are available. All content is available on the ams website, 
www.ams.com. 


